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1 Hardware and Functionality

Blue Lizard is a telescope controller for driving
bipolar stepper motors connected to equatorial
telescope mounts. It is capable of providing up to
3.0 A current per coil and its resolution can be set
as low as 1

128 microsteps. The main interaction with
peripherial software such as planetarium programs
takes place via WLAN. Blue Lizard either spawns a
WLAN of it own or it can be integrated into an ex-
isting network infrastructure. It supports commu-
nication with SkySafari1 on Android or iOS oper-
ating systems for tablets, but it can also communi-
cate via INDI2 and ASCOM3. The basic command
set is a subset of the well-known LX200 protocol.
Blue Lizard also supports guiding commands via
ST4, and it features compact handbox. For tele-
scope control via ASCOM, a dedicated USB inter-
face translating the commands from the Advanced
LX200 ASCOM Driver4 to the wireless interface of
Blue Lizard is available. Internally, the Blue Lizard
controller is powered by a Raspberry Pi microcom-
puter and an ARM Cortex-M4 microcontroller run-
ning at 180 MHz. In addition, date and time are
stored in an internal high precision clock.

2 Setting things up

After connecting a sufficient power source provid-
ing 12 V, Blue Lizard can be turned on using the
On/Off button (marked b in Fig. 1). As the Rasp-
berry Pi microcomputer has to boot, it might take
up to 20 seconds until the front display shows oper-
ation. A beep is heard when Blue Lizard is ready.

Initially, the display shows the date and time as

1www.skysafariastronomy.com
2www.indilib.org
3www.ascom-standards.org
4www.pixelstelescopes.wordpress.com/advanced-lx200

Figure 1: Back panel of Blue Lizard. a denotes the
power insert for a minimum operating voltage of 12
V DC, b is the power switch and c is the momentary
switch for shutting or rebooting Blue Lizard. d is
the ST4 port, which either processes input from
an autoguiding system such as the Lacerta MGEN
or a handbox. e and f are a USB-to-Serial (for
ASCOM) and RJ45 interface to the Raspberry Pi.
g is an LED that is lit when the system is powered
up.

Figure 2: After starting up the controller, the sys-
tem time and date as stored by the internal clock
of Blue Lizard are displayed, together with the pre-
ferred communication method for displaying the
position of the telescope on a planetarium program,
cell phone or tablet.
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stored in the internal real-time clock, and the cho-
sen method of communication with external soft-
ware (Fig. 2). At this stage, one can now start to
connect to the internal webserver of Blue Lizard
and the controller can be parametrized.

Figure 3: Selection of the wireless access point of
the Blue Lizard controller. By default, the name
is Lacerta xxx, where xxx is the serial number
of your personal device. The default password is
Lacertaxxx without the ” ” character.

In order to connect to the webserver of Blue
Lizard, one needs to locate the internal WLAN ac-
cess point; per default, this is Lacerta xxx, where
xxx is the serial number of your controller. Fig.
3 shows this selection process on an iPad. On a
conventional computer, one simply has to connect
to the this WLAN access point. The default pass-
word is Lacertaxxx without the ” ” character. If
your controller reads, for instance, 22 012 as the se-
rial number, the password is Lacerta012. Once you
have connected, you can start any web browser and
type the IP address of the controller, which is by
default 192.168.4.1. Fig. 4 shows the resulting
screen.

2.1 The telescope parameter set-
tings

� Observatory Name: This is just an arbi-
trary name for your controller. Any combina-
tion of letters is fine here.

� Longitude and Latitude: Your current posi-
tion. In Sect. 4, we will learn of an automated
way to set this position by using SkySafari.

Figure 4: View of the configuration screen; after
connecting your computer to the WLAN access
point of Blue Lizard, one can open a web browser
and type the default address 192.168.4.1 of the
controller into the address line. The configuration
details are explained in the text.

� WLAN-Port: The network port to connect
to. The default port 50001 is fine and there is
no obvious reason to change it.

� Communication method for telescope
positioning: Here we have several choices;
Sky Safari needs to be checked if SkySafari is
to be used as the main display for showing the
telecope position. INDI starts an INDI server
that handles the simple LX200 commands for
synchronizing, slewing and manual position-
ing of the scope. The well known programs
Stellarium5 and KStars – which is well known
from the Astroberry6 distribution – are exam-
ples of programs that support communication
over this protocol. The option TCP/IP al-
lows communication directly over the WLAN.
KStars supports the LX200 protocol directly
via TCP/IP. As you may have noticed, Blue
Lizard has very little display capabilities of
its own – it is designed to use a planetarium
program for interaction. Details about con-
necting various programs are found in Sect. 3.
Serial connects to the internal USB-to-Serial

5www.stellarium.org
6www.astroberry.io
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converter of Blue Lizard; users of ASCOM will
find an emulated COM-Port here.

2.2 Right Ascension Drive Settings

� # of worm teeth in right ascension: The
number of teeth on your right ascension worm
wheel. If you have a different drive, for in-
stance a friction drive, you can set this value
to 1.

� Intermediate gear factor in right ascen-
sion: If you have, for instance, a belt drive
which adds a reduction factor, you should set
this factor here. In a friction drive, you can
also set the ratio of the diameters for the driver
and the roller wheel there. If no intermediate
gear is used, set this value to 1.

� Planetary gear factor in right ascension:
Here, you can add an additional gear factor
for a planetary drive that is connected to your
stepper. If you do not have a planetary gear
connected, set this value to 1.

� °per step in right ascension: This is the
rotation of your stepper for a full step. 200
steps (or 1.8°) are a very common measure.

� Microstepping ratio for tracking and
guiding in right ascension: The controller
can move the stepper with utmost precision.
At highest resolution, the 1.8°full step is sub-
divided into 128 microsteps, resulting in a dis-
crete motion of only 0.85 minutes of arc. This
is a useful mode for fine motion, but as the
speed of the motor is limited, it makes no sense
to use such a fine resolution for every motion.
Here we recommend to go for the 1

128 resolu-
tion.

� Microstepping ratio for motion in right
ascension: Motion in this case refers to moves
which are controlled via the handboxes. Blue
Lizard knows four speeds, which are multiples
of the sidereal motion; here, we talk about the
intermediate level. 1

16 is often fine in this case,
but it can be set to a smaller or higher value.

� Microstepping ratio for slewing in right
ascension: This is the microstepping ratio for

the fastest mode when the telescope is posi-
tioned. We use the rather coarse 1

4 microstep-
ping ratio in this case.

� [microsteps2/s] - Acceleration in right
ascension: Due to inertia, a motor cannot im-
mediately jump from rest to a desired speed.
This would require an infinite acceleration
value and therefore infinite force and current.
A defined acceleration helps to precisely reach
the desired speed while keeping the power con-
sumption within limits. A value between 5000

and 10000 microsteps2

second is usually chosen. Too
high an acceleration leads to step losses and
even a stop of the motor.

� [mA] - Maximum current for right ascen-
sion drives: Setting the optimum coil current
is crucial for precise action. The maximum coil
current for the motor is given in its specifica-
tions. A rule of thumb says that one may start
with 70% of this value. If your maximum coil
current is, for instance, 1.5 Ampere, you can
start with 1000 [mA]. If the motors get hot af-
ter a while or if they are very noisy, you may
reduce this value. If you drive loses steps –
this leads to an intermediate irregular noise
especially at higher speeds after the accelera-
tion phase, or if the drive does not move at all,
your current is too low.

The procedure is the same for the declination
drive. A well set motor is very silent, does not
loose steps or stops at higher speeds (this behaviour
is also called stalling) – it just moves your scope
smoothly. The power available to the drivers is con-
siderable – we have driven telescopes with a moving
mass of 300 kg with NEMA 23 motors connected
to a 1:9 planetary drive, a worm wheel of 288 teeth
and a motor current of 1.5 [A].

2.3 Holding current and general
drive settings

� Holding current: This is the fraction of the
coil current supplied to the motor if the drive is
stopped. In microstepping mode, it might hap-
pen that a motor drained of all power might
snap into a convenient state – usually the next
full step. In order to provide maximum accu-
racy in small movements – like guiding – it is
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Figure 5: The second part of the configuration
screen shown in Fig. 4. The settings are explained
in the text.

necessary to power up the motor at rest. How-
ever, it makes sense to reduce this current to
a fraction of the current needed to move the
drive. This is the holding current. Here, one
can set the fraction of the maximum current
for holding a drive.

� Fraction of sideral speed for guiding:
Guiding in astrophotography refers to subtle
movements for correcting mechanical imper-
fections of the mount. It makes sense to carry
out these movements in a fraction of the side-
real speed. Any value greater than 0 and below
or equal to 1 is fine. Do not forget to provide
this ratio to your guiding software/hardware as
well!.

� Multiple of sidereal speed for handbox
motion: The protocol for sending commands
to Blue Lizard – the Meade LX200 protocol
– knows 4 different speeds. Two of them are
slow – the base speed (usually the speed nec-
essary to track the motion of the stars, the
sidereal speed) and a fraction of it, the guiding
speed. There are also two faster speeds avail-
able. Handbox motion is the speed that is set
here; it is a multiple of the sidereal speed that

allows a comfortable tracking of motion in your
favourite eyepiece.

� Multiple of sidereal speed for slewing:
This is the maximum speed available – it is
used for positioning your scope to celestial ob-
jects. Again, the factor set as a multiple of the
sideral speed.

2.4 Meridian flip settings

Here, we are dealing with a complex matter; users
of German Equatorial Mounts (GEMs) like the For-
nax or SkyWatcher mounts need to read this sec-
tion carefully. Users of fork mounts or bent knee
tripods may simply turn the meridian flip off.

� Meridian flip is off? Check this option if
your mount is not a GEM and does not need
to carry out a meridian flip. A GEM has two
possible positions when looking at the south
horizon; the scope can be east of pier or west
of pier. In both situations, we look at the same
position. When moving your scope, it might
happen that the shortest path is not feasible as
it would cause a crash of the eyepiece into the
pier or tripod. Thus, it is necessary to carry
out a meridian flip – the scope moves up to the
celestial north (or south) pole and moves back
to the declination of the object desired. The
right ascension axis does also not move for a
desired amount of degrees ∆, but by 360°- ∆.
After a meridian flip, the image on the eyepiece
or on the sensor is rotated by 180°.

� Maximum declination where no merid-
ian flip for GEM is triggered: At low decli-
nations, for instance when following the hori-
zon from southeast to southwest, a meridian
flip may be unnecessary as the eyepiece never
gets close to the pier (or tripod). If you are
insecure about this, set this value to the min-
imum declination that can be reached from
your observing site.

2.5 Park Position Settings

Blue Lizard features a small computer. A proper
shutdown sequence is to be instantiated by press-
ing the Shutd. button (c if Fig. 1) for 2 or 5 sec-
onds. If this routine is instantiated, you can tell
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your mount to go to a defined position – this is the
Park Position.

� Go to parking position at shutdown: If
you uncheck this, the mount will simply stop at
its current position and Blue Lizard will cease
operation.

� Parking positions: A number of predefined
postions can be chosen; these are:

– Southern Horizon: The south horizon
as visible form your position.

– Eastern Horizon: The East horizon.

– Western Horizon: The West horizon.

– Zenith: The zenith – your scope point
straight up into the heavens.

– Nadir: The same as zenith if you are on
the southern hemisphere.

– Northern Celestial Pole: The position
of Polaris – probably a classical posiiton
for a GEM.

– Southern Celestial Pole: The same
classical GEM position if you are on the
southern hemisphere.

– Entered values below: A custom posi-
tion enterd in the following text fields.

� Hour angle for parking position: If a cus-
tom position is chosen by selecting Entered val-
ues below: in the selection, this is the desired
hour angle for the parking position.

� Declination for parking position: Same as
above – the declination for a custom parking
position.

2.6 Invert Mount Direction Settings

A bipolar stepper motor has four relevant wires;
often, these are given as Green-Black and Red-Blue
pairs. These are the four relevant leads. There may
be more, but these are not relevant here. The wire
pairs are denoted as A-A’ and B-B’ and they denote
the leads to the two coils of the drive. If the relative
resitance between two wires is close to zero, they
belong to the same coil. Otherwise, the resistance is
infinite. By permutating the wires, one can change
the default rotation direction of the stepper drive.
Or it can be done here.

� Invert Right Ascension direction?: In-
verts the default direction of the right ascen-
sion drive. This may also be necessary if you
move from one hemisphere to the other – e.
g. when going from Europe to an African or
Latin American country located south of the
equator.

� Invert Declination direction?: Inverts the
default direction of the declination drive.

Denote that the direction in declination can also
be inverted if the initial position of a GEM con-
cerning West-of-Pier/Right-of-Pier is given in the
wrong fashion – more on this in Sect. 6.

2.7 Check your settings

After setting everyting up, it is necessary to con-
vey the data to the software – this is done by push-
ing the Submit Query button visible in Fig. 5. Af-
ter that, the settings can be checked in the next
browser page as shown in Fig. 6. Now it is nec-
essary to restart the controller software. This can
be done via the Shutdown button in the broser as
shown in Fig. 6. But in this case, the WLAN con-
nection is lost, and one has to reboot Blue Lizard
completely. A more elegant version of reset and
shutdown is described in Sect. 2.8.

2.8 Shutdown or restart using the
Shutd. – Button

As you may know, it is not recommended to shut
down your computer by simply turning off the
power – rather than that, a shutdown has to be
instantiated. As Blue Lizard features a computer
as its main element, we also need to shut it down
properly, but as we do not have a keyboard con-
nected, this can be done in a different way using
the Shutd. button, denoted as c in Fig. 1.

� Press Shutd. for more than 2 and less
than 5 seconds: Blue Lizard will not shut
down, but it will restart the controller software
– the WLAN access point remain alive, and
after approximately 10 seconds, the software
comes back to life. This is recommended when
setting the system up as described ins Sects.
2.1 – 2.6.
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Figure 6: After submitting your settings via
the Submit Query button on the parameter page
in your browser, the stored parameters can be
checked. It is necessary to restart the controller,
or to shut it down. Shutdown is possible via the
Shutdown button in the browser window, or by op-
erating the Shutd. button (c in Fig. 1). With this
button it is possible to restart the controller soft-
ware without shutting BlueLizard down.

� Press Shutd. for more than 5 seconds:
Blue Lizard shuts down completely; after ap-
proximately ten seconds, it is safe to discon-
nect the power, either by using the Off/On
switch (b in Fig. 1), or by disconnecting the
power. A restart is initiated by toggling the
Off/On switch.

3 Planetarium programs

Figure 7: The Setup screen of Sky Safari Plus
– here, the basic settings for connecting to Blue
Lizard are shown.

Once all is set up, one can do first tests; as Blue
Lizard only has very limited display functionality,
it is necessary to connect a planetarium program.
The following programs were tested:

3.1 Sky Safari

Take care that the connection method selected is
Sky Safari as described in Sect. 2.1. The procedure
is the same for iOS and Android.

� Connect to the access point of Blue Lizard as
shown in Fig. 3.

� You need an advanced version of Sky Safari
such as Sky Safari Plus, which is available for
a few Euros in the App Stores.

� Start Sky Safari and go to the Settings menu;
in the Telescope menu (Fig. 7), choose

– Scope type → Meade LX200 Classic.
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– Mount type → Equatorial GoTo (Fork).
This is necessary in order to avoid that
both Blue Lizard and the planetarium
software trigger a meridian flip on a
GEM.

– IP Address → 192.168.4.1 (or whatever
the IP address of Blue Lizard is).

– Port Number → 50001 (or whatever port
was set in the settings).

– Turn on Set Time & Location by moving
the switch to the right – this synchronizes
the internal real-time clock of Blue Lizard
and sets the location as received by the
GPS-receiver of your tablet.

– Readout Rate → 10 per second.

– Confirm by pressing Done in the upper
right corner.

� Now go to the Scope menu in the main screen
of Sky Safari and press Connect (Fig. 8).

� After connection – this may take a few seconds
– the location of the scope is displayed as a
crosshair (Fig. 9). Motion buttons appear on
the left and right side, four different speeds can
be selected in the Rate menu, and it is possible
to syncronize the scope to a star with the Align
button. One can select a celestial object and
trigger a slew by selecting the GoTo command.

Figure 8: By selecting the Scope menu in Sky Safari
Plus or higher versions, one can now connect to the
controller.

Figure 9: The interface for controlling Blue Lizard
after connection to Sky Safari.

3.2 INDI

INDI is a very powerful server concept for connect-
ing all kinds of astronomical hardware in a net-
worked environment. Amongst others, INDI can
of course handle the LX200 command set for tele-
scope control. Two examples of planetarium pro-
grams connecting to an internal INDI server of Blue
LIzard are presented in this section.

3.2.1 Stellarium

Select INDI in the setup as described in Sect. 2.1
and restart Blue Lizard. Now you can connect to
Blue Lizard via an INDI server. Two popular pro-
grams usnig INDI are Stellarium and KStars – the
latter is very well known for its integration with the
Astroberry distribution.

� Connect your computer to the wireless access
point of Blue Lizard.

� Start Stellarium, open the Configuration Win-
dow in the left popup menu (or by pressing
F2), scroll to Plugins → Telescope Control,
check Load at startup and click configure. See
also Fig. 10.

� Select INDI/INDIGO, give your telescope a
name, set an equinox and a short connection
delay, and check whether you want to connect
at startup (Fig. 11).
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� Scroll down in the Telescope properties subdi-
alogue and select the IP address of the host
running the INDI server (that is actually Blue
Lizard) to 192.168.4.1 (or whatever the IP Ad-
dress of Blue Lizard is). Set the Port to 7624
– that is the default port used by INDI. If you
push the Refresh devices button, you will see
that a connection to an INDI server running
the LX200 Basic protocol is established. Now
you can close these dialogues. See also Fig. 12.

� Now you can close all dialogues; by press-
ing the Telescope button in the lower popup
menu of Stellarium, you can open the INDI
dialogue. The coordinates of a selected object
can be transferred with the Current object but-
ton, and one can align or slew to this object.
Manual motion with direction buttons at the
four different speeds of LX200 is also possible
(Fig. 13).

Figure 10: The Plugins menu of Stellarium, where
the INDI interface is selected.

3.2.2 KStars and Astroberry

KStars is a very powerful program that fully in-
tegrates with INDI and it also features a powerful
scheduler for astrophotography called EKOS. Here,
we just show how KStars connects to the internal
INDI server of Blue Lizard running a LX200 Basic
driver. KStars has become quite popular as it is the

Figure 11: The first part of the Configure Telescope
screen of Stellarium. INDI/INDIGO needs to be
selected as the connection method.

Figure 12: Set the proper IP addres of Blue Lizard,
set the port to 7624, and connect to the INDI
server.
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Figure 13: Telescope motion with INDI in Stellar-
ium. The Telescope button in the bottom menu
opens a dialogue for interaction with the controller.

central component for the Astroberry distribution
for the Raspberry Pi.

� Start KStars, and select Tools → Devices →
Device Manager . . . – see also Fig. 14.

� Open the Client tab and Add the INDI server
by entering a name, the IP Address of Blue
Lizard and again the port of the INDI server
on Blue Lizard – this is fixed to 7624 (Fig. 15).
Press Connect to connect to the INDI server of
Blue Lizard.

� By right-clicking in the main window of
KStars, you can open the LX200 Basic menu
for telescope operation (Fig. 16).

3.2.3 TCP/IP and ASCOM

In order to use the LX200 command set directly via
TCP/IP, you have to select TCP/IP in the setup
as described in Sect. 2.1 and restart Blue Lizard.
For ASCOM use, need to download the Advanced

Figure 14: Connecting to an INDI Server in KStars
is especially easy – just open the Tools → Devices
→ Device Manager . . . dialogue . . .

Figure 15: . . . and Add the INDI server of
Blue Lizard with the appropriate IP Address
(192.168.4.1 by default and the port 7624. Click
Connect to establish a connection and close all
dialogues.
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Figure 16: After conenction, the LX200 Basic
menu can be opened by a right-click with the
mouse.

Figure 17: Selection of the ASCOM interface in
Cartes du Ciel. Denote that INDI is available as
well . . .

Figure 18: The interface of the Advanced LX200
ASCOM driver. The COM port selected is the
USB-to-Serial interface of noted as USB 2 on the
controller.

LX200 ASCOM driver7 and connect the USB port
of your computer to the USB2 outlet of the con-
troller. The interface needs to be set to Serial.

In this example, we connect Cartes du Ciel8 via
ASCOM to Blue Lizard. The operating system
used here is Windows 10.

� Go to Telescope → Telescope Settings and se-
lect ASCOM as the telescope interface (Fig.
17).

� Select the Advanced LX200 ASCOM driver
that needs to be installed beforehand. The
COM-port offered is most likely the USB-to-
serial converter of Blue LIzard (Fig. 18). De-
note that the meridian flip can also be trig-
gered by the driver here (Fig. 19). If you
choose this option, the meridian flip has to
be disabled in the Blue Lizard controller. In
this case, the controller does the meridian flip,
therefore we set the ASCOM driver to a fork
mount (Fig. 19).

� Once all is set up, a connection can be estab-
lished (Fig. 20) and a right click on an object
allows to align or slew the telescope. Denote

7https://pixelstelescopes.wordpress.com/advanced-
lx200/

8https://www.ap-i.net/skychart/en/start
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that synchronization of Hiawatha and the pro-
gram can be complicated. The central button
on Hiawatha allows to reset the interface.

Figure 19: The Advanced LX200 ASCOM driver
allows to trigger a meridian flip as well. Greatest
care has to be taken that only one of the two devices
– the driver or Blue Lizard – perform a meridian
flip in a GEM.

It is also worth mentioning that KStars allows a
direct LX200 connection via the serial interface to
Blue Lizard.

4 Setting time and location

At this point, you are almost done – the mount
parameters are entered, the planetarium program
is connected – but you still need to set the time
for the controller, otherwise it is not possible to
translate celestial coordinates given in right ascen-
sion and declination to topical coordinates of hour
angle and declination. Therefore, you have to set
the real time clock of Blue Lizard. The RTC is
a battery powered DS3231 chip, it is temperature
compensated and the battery should keep the time
for a number of years. Of course it is possible to
replace the CR1220 battery once it is drained. But
one has to set the time.

Your Blue Lizard should come with the time and
date set properly. Upon startup, you can check this

Figure 20: Once the ASCOM driver is set up, one
can connect via USB 2 to Blue Lizard. A right click
on a celestial object opens the command interface
to control the telescope. Denote that it is also pos-
sible to set the time via the ASCOM interface.
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as the time and date of startup are displayed on the
small screen attache to Blue Lizard (see also Fig.
2). If that time is not correct, the time has to be
set. There is a multitude of methods to do this:

� Set the time via LX200 and Sky Safari:
As shown in Fig. 7, one can force Sky Safari
to submit the topical time and location – this
is extremely useful for mobile use. Setting the
time also synchronizes the RTC.

� Set the time with LX200 on a computer:
Some interfaces like the ASCOM LX200 driver
and KStars also allow for synchronization via
LX200 (see also Fig. 20). This works in the
same way as for Sky Safari – but take care
that the time on you computer is set properly.

It is also possible to set the time manually, this
is described in Sect. 8.

5 The handbox

A handbox is available for Blue Lizard. It connects
to the ST4 port with a twisted RJ12 cable.

The handboxes have an hierarchical order – if any
of the two handboxes is connected, LX200 handbox
commands such as the direction buttons of Sky Sa-
fari are disabled. Therefore it is made sure that
only one handbox at a time can issue commands.

6 Operation

Once all is set up, the time and date are set and
all is connected, Blue Lizard simply responds to
your commands via the planetarium program or the
handbox. However, during startup there is another
important phase when using a GEM - you have
to tell the controller whether the mount is located
LEFT or right of the pier. The controller starts
beeping in that phase and the small display asks Is
scope LEFT?. If the the scope is indeed located
on the left side of the pier (this is also called East-
of-Pier when looking at the south horizon, you do
not have to do anything. If the scope is on the right
side of the pier, push the momentary East/West
button on the front panel. This is marked as button
c in Fig. 2.

You can also change the tracking speed by press-
ing the momentary Speed button (marked as b in

Fig. 2). If you push this button, the tracking speed
changes from sideral speed to lunar and solar speed.

7 Guiding via ST4

Guiding via ST4 is realized when connecting a
straight RJ12 cable to the ST4 port (marked as d

in Fig. 1). This cable can be connected to the ST4
port of a camera or to any ST4 guider such as the
Lacerta MGEN. When a guiding command is re-
ceived, Blue Lizard goes into a Guide mode. This
is displayed on the front display. In guide mode,
Blue Lizard ignores most external commands –
the handbox is disabled, and one cannot send any
LX200 commands. After 30 seconds when no com-
mands are reaching the system any more, Blue
Lizard leaves the guide mode and resumes normal
operation.

8 Connecting to Blue Lizard
via RDP

If you want to see what is happening under the
hood, you can also connect to the raspbery directly
via RDP.

Above all, it is possible to set the real time clock
here. Open an additional terminal window and
connect Blue Lizard via an Ethernet cable to your
router. After a few seconds, the time should be
set. If you type sudo hwclock -w into the ter-
minal, your clock should be set as well. Typing
the command sudo timedatectl set-time ’yyyy-
mm-dd hh:mm:ss’ followed by sudo hwclock
-w, the internal hardware clock can be set, for in-
stance after a battery change.
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